01. The Camera Raw Interface - Working with Panels and Sliders and Tools

- Tap F to toggle Full Screen Mode.
- Command + 1, 2, 3-9 (Mac) | Control + 1, 2, 3-9 (Win) displays the corresponding edit panel (Basic, Curve, Detail etc.).
- Several panels (Detail, Effects, etc.) have additional options which can be accessed by clicking on the white progressive disclosure triangles.
- Double click the slider handle to reset the slider.
- To reset all sliders in a panel, hold Option (Mac) | Alt (Win) and click Reset (PanelName).
- To preview edits on a per-panel basis, click and hold the Preview icon (the eye) to the right of the individual panel name.
- To reset an image, click the More icon (the three dots) and choose between Reset to Open and Reset to Default.
- Click in any text entry area to enter specific numeric values. Tap the Tab key to move to the next text entry. With the text entry highlighted, use the up/down arrow keys to modify existing values. Add the Shift key to modify in larger increments.
- A small white dot to the right of the tool, signals that there have been changes made with the tool.

02. The Filmstrip

- Tap forward slash (/) to toggle the visibility of the filmstrip.
- Command + Shift + F (Mac) | Control + Shift + F (Win) toggles the orientation of the Filmstrip.
- Position the cursor over a thumbnail in the Filmstrip and click the More icon (the three dots) to access additional options such as Show Filenames, Show Ratings & Color Labels (or Control -click (Mac) | right -click (Win) on the thumbnail and use the context sensitive menus).

03. Adding Ratings and Labels

- Use the numeric keys 1-5 to apply star ratings.
- Use the numeric keys 6-9 to apply color labels.
- Command + “,” or “.” (Mac) | Control + “,” or “.” (Win) will decrease/increase star ratings.
- Option + Delete (Mac) | Alt + Backspace (Win) marks an image as Rejected.
- Tap Delete to mark an image for deletion. Control -click (Mac) | right -click (Win) to unmark via the context sensitive menus.

04. Zooming and Panning Images

- Tap the H key to select the Hand tool.
- With most other tools selected, press the Spacebar to temporarily access the Hand tool.
- Tap the Z Key to access the Zoom Tool.
- Clicking in the image area with the Zoom tool toggles between Fit in Window and 100%. Use the Zoom Level selector (lower left) to change the default “zoom in” level.
- Command + 0 (Mac) | Control + 0 (Win) will fit the image within the preview area (Fit In View).
- Option + Command + “0” (Mac) | Alt + Control + “0” (Win) sets the view to 100%.
- Command + “+” (plus) (Mac) | Control + “+” (plus) (Win) zooms in.
- Command + “-” (minus) (Mac) | Control + “-” (minus) (Win) zooms out.
- Command -drag (Mac) | Control -drag (Win) to zoom into a specific area.
- Click -drag left/right to zoom out/in with the Zoom tool (Scrubby Zoom).
- With most other tools selected, Press and hold Command (Mac) | Control (Win) to temporarily activate to the Zoom tool. Note that you can drag click -drag left/right to zoom out/in with the Zoom tool.
- Select a zoom level from the Zoom percentage icon in the lower left.
- For quick navigation to a specific area, use Birds Eye View.
  - Press and hold the H key.
  - Click-and-hold the mouse down in the image area. The image zooms in and a rectangle appears.
  - With the mouse still held down, reposition the rectangle over the area that you want to zoom to.
  - Release the mouse. The image zooms in to the rectangular area. Release the H key (the originally selected tool remains unchanged).
  - Note: Birds Eye View is only available when GPU is enabled in the Camera Raw Preferences > Performance > Use Graphics Processor.
• When moving from one image to another in the filmstrip, the zoom percentage and location will stay constant. To vary the zoom between images disable Global Zoom Editing from the Zoom Level popup in the lower left.
• If you prefer the Zoom tool to automatically swap to the hand tool when zoomed into 100%, click the Settings icon (the gear) and choose General > Zoom and Pan and enable “Use Lightroom Style Zoom and Pan”.

05. Navigating Through a Document Screen By Screen
• Tap the Home key to move to the top-left corner of the image. Tap the End key to move to the bottom-right corner of the image.
• Tap the Page-down key to move down one full screen. When you reach the bottom of the image, tapping the Page-down key again takes you to the top and to the right by one full screen. Tapping the Page-up key does the same thing, but in the opposite direction.
  - Note, on a laptop, use the function key and the left/right arrows to move to the Home/End (top left and bottom right) and the up/down arrows to navigate Page Up/Down (screen by screen).

06. Multiple Undo
• Command + Z (Mac) | Control + Z (Win) goes back in time (Multiple Undo), will toggles (Undo/Redo) the last change made.
• Command + Shift + Z (Mac) | Control + Shift + Z (Win) goes forward in time (Multiple Redo).
• Command + Option + Z (Mac) | Control + Alt + Z (Win) toggles the last state off/on (after the most recent command)

07. Crop, Straighten, and Rotate Tools
• Tap the C key to select the Crop tool.
• When you first select the Crop tool, click and drag in the image area to set the crop or, use the handles to resize the crop. Drag within the crop marquee to reposition.
• Option -drag (Mac) | Alt -drag (Win) the crop handles to transform the crop from the center.
• Position the cursor outside of the crop marquee (the icon will change to the double headed arrow), and drag to rotate the angle of the crop.
• Select an aspect ratio from the list or, select Custom and enter values (ACR will save the last 5 custom aspect ratios entered).
  - Tap X to flip the crop aspect ratio (landscape to portrait/portrait to landscape).
  - Option + A (Mac) | Alt + A (Win) toggles the lock aspect ratio option
• Tap the A key to select the Straighten tool.
  - Double click the Straighten tool to automatically straighten the image (this works best with images that have a strong horizontal line).
  - With the Crop tool selected, hold the Command (Mac) | Control (Win) to temporarily activate the Straighten tool.
• Command + Option + drag (Mac) | Control + Alt + drag (Win) with the Crop tool to temporarily invoke the Zoom tool.
• Choose another tool, double-click within the crop marquee, or tap Return (Mac) | Enter (Win) to apply the crop.
• With the Crop tool selected, Command + Option + R (Mac) | Control + Alt + R (Win) will reset the crop.
• Tap Escape to reset the crop and dismiss the Crop tool.
• The Crop tool is solely responsible for defining the aspect ratio of the crop. Use the Save and Workflow options to determine image size.
  - For example, in order to create an image that is 8 x 10 inches at 300 ppi, select 4 to 5 from the list of aspect ratios and drag the crop in the image as desired. Then, when using the Save or Workflow options, check Image Sizing, select Short Size from the drop down menu and enter 8 inches and a resolution 300 ppi.
• Tap the V key to view the Crop overlay. Option + V (Mac) | Alt + V (Win) toggles through Overlay styles (or Control -click (Mac) | right -click within the crop marquee choose from the list of Overlay Styles).
• Command -click (Mac) | Right -click (Win) within the crop marquee to access many of the Crop options via the context sensitive menu.
• Tap the R key to rotate an image clockwise or use Command + “)” (Mac) | Control + “)” (Win)
  - Tap the L key to rotate counter clockwise or use Command + “)” (Mac) | Control + “)” (Win).

08. Edit
• Command + U | Control + U (Win) applies Auto Tone to an image.
• Clicking the B&W icon automatically applies the Adobe Monochrome profile.

09. Profiles
• Within the Profile browser, double click a profile to apply it and exit the browser.
• Within the Profile browser, click the Star icon to add the profile to Favorites. Then, use the Profiles drop down list to quickly access Favorites (without having to enter the Profile browser).
• Within the Profile browser, click the More icon to change View options (List/Grid/Type), Reset, Manage, and Import/Export profiles.
10. The Histogram

- Control -click (Mac) | Right -click (Win) in the Histogram to enable Lab color readouts.
- Click -drag within the Histogram to adjust the Blacks, Shadows, Exposure, Highlights, and Whites slider adjustments in the Basic tab.
- Tap the U key (underexposed) to preview areas in an image that are clipped to pure black by displaying a blue overlay.
- Tap the O key (overexposed) to preview areas in an image that are clipped to pure white by displaying a red overlay.
  - Note: the Clipping Warning triangles turn different colors to show that different channels are being clipped:
    - If no values are clipped, the triangles are black.
    - If values are clipped in all channels, the triangles are white.
    - If values are clipped in the red channel the triangles are red.
    - If values are clipped in the green channel the triangles are green.
    - If values are clipped in the blue channel the triangles are blue.
    - If values are clipped in the red + green channel the triangles are yellow.
    - If values are clipped in the red + blue channel the triangles are magenta.
    - If values are clipped in the green + blue channel the triangles are cyan.

11. The Basic Panel

- White Balance
  - Tap the I key to select the White Balance tool.
  - The White Balance Tool’s sample area is dependent on zoom level (zoom in to sample a smaller area).
  - Double click the White Balance icon to reset the White Balance to “As Shot”.
  - Camera Raw displays a list of “preset” White Balance settings (Auto, Daylight, Cloudy, Tungsten etc.). This list differs slightly from camera to camera. When working with JPEG files, As Shot, Auto, and Custom are the only White Balance menu options.
  - The White Balance values displayed for RAW and JPEG files will differ. The Temperature and Tint sliders will display numeric values from -100 to +100 for JPEG files as opposed to Temperature (2000-50000) and Tint (-150 - +150) values for RAW files.
  - Shift -double click the Temperature or Tint slider handle to apply Auto Temperature and Auto Tint.

- Toning (Exposure, Contrast, Highlights, Shadows, Blacks, Whites)
  - Command + U | Control + U (Win) applies Auto Tone adjustments to an image (or click the Auto button in the Edit section).
  - Shift -double click the Exposure, Highlights, Shadows, Whites, or Blacks slider handle to apply Auto settings
  - Option -drag (Mac) | Alt -drag (Win) the Exposure, Highlights, Shadows, Whites, or Blacks sliders to preview clipped values in an image on a per channel basis.

- Texture can be used to decrease or increase the appearance of “texture” in a photograph while still retaining fine details.
  - Moving the Texture slider to the left will reduce unwanted, medium-sized details (for minimizing skin texture or smoothing surfaces for example), while moving the Texture slider to the right enhances medium-sized details in a photograph (for intensifying the texture of foliage or hair for example).

- Clarity is biased to increases/decreases midtone edge contrast (not full-range or overall contrast).

- Dehaze is based on a physical model of how light is transmitted, estimating the amount of light that is lost due to absorption and scattering through the atmosphere. Move the slider to the right to remove the haze, move the slider to the left to add a creative haze effect.
  - Dehaze makes dramatic changes to the shadows and lower portion of the Histogram while only slightly adjusting the highlights.
  - For the best results, set the white balance for the image before using Dehaze.
  - Option (Mac) | Alt (Win) -drag the slider to preview areas that are being clipped to pure black without detail.

- Vibrance is a relative and biased slider - it increases/decreases the amount of color in an image based on how much color there was to begin with and, it adjusts orange, red, and yellow values less than other colors. Vibrance can be very useful when increasing saturation in blue sky, green grass etc., while avoiding most shifts in skin-tones.

- Saturation is an absolute adjustment. Moving the slider to -100 will remove all color from an image, +100 will fully saturate colors in an image.

12. The Curve Panel

- Use the icons across the top of the Curve panel to move between Parametric, Point Curve, and individual Red, Green, and Blue channels. or, use Option + 1, 2, 3, 4 (Mac) | Alt + 1, 2, 3, 4, to select the Composite, Red, Green, and Blue channel.
- Command + Option + Shift + T (Mac) | Control + Alt + Shift + T (Win), selects the Targeted Adjustment tool for the Parametric Curve. Click -drag up/down in the image area to raise/lower the value clicked upon.
• Command + Option + Shift + P (Mac) | Control + Alt + Shift + P (Win), selects the Targeted Adjustment tool for the Point Curve.

• When using the Parametric curve:
  - Drag the Highlights, Lights, Darks, and Shadows sliders to lighten/darken the image.
  - To change the tonal range affected of any of these sliders, reposition the dots directly under the curve to adjust the “splits”.
  - Control -click (Mac) | Right -click (Win) in the Parametric Curve grid area to quickly reset regions and splits.

• When using the Point Curve:
  - Command -click (Mac) | Alt -click (Win) in the image area to set a point on the curve.
  - Drag to reposition the point in the Tone Curve panel or use the up, down, left, right arrow keys to precisely reposition the point as necessary.
  - A maximum of 16 points can be added to each curve to make color corrections and/or add creative effects.
  - Select the Red, Green, or Blue Channel icons (the circles) to adjust the individual red, green, and blue channels.
  - Plus (+) and Minus (-) move between control points on the Curve.
  - Tap the D key to deselect the Curve.
  - Shift -click to select multiple points in the Curves panel at once.
  - Use the Input/Output text boxes to adjust the value of any selected control point.
  - With a point selected, tap Delete to delete individual points on the Point Curve or, click -drag the point off the curve.
  - Control -click (Mac) | right-click (Win) in the Point Curve grid area to access additional options including: Reset Channel, Reset All Channels, Copy/Paste Channel Settings, and Show All Curves.

13. The Detail Panel
• Zoom into 100% to accurately view the effects of Sharpening and Noise Reduction.
• When sharpening, the amount is the amount of contrast added to edges and the Radius determines how many pixels along the edge are effected. The Detail and Masking sliders suppress sharpening in the lower contrast areas of an image. As a rule of thumb, the Detail slider is better at suppressing sharpening in high-frequency images such as landscapes while the Masking slider is better when working with portraits.
• Option -drag (Mac) | Alt -drag (Win) the Radius, Detail and Masking sliders (as well as the Luminance sliders in Noise Reduction), to display a greyscale preview of the slider’s effect. Previewing the edges of the masks (when using the Detail and Masking sliders), can be helpful in determining which option is best for the image that you're working on.

14. Color Mixer / B&W Mixer Panel
• To adjust individual color ranges in an image, use the Color Mixer Panel.
• Use the Adjust menu to choose between two different ways of visualizing color - Color and HSL. The only feature difference between the two visualizations is that the Targeted Adjustment Tool is available when using HSL.
• Use the Targeted Adjustment tool to click-drag up/down (or left/right) in the image area to increase/decrease the color range clicked upon.
  - Command + Option + Shift + H (Mac) | Control + Alt + Shift + H (Win) selects Hue.
  - Command + Option + Shift + S (Mac) | Control + Alt + Shift + S (Win) selects Saturation.
  - Command + Option + Shift + L (Mac) | Control + Alt + Shift + L (Win) selects Luminance.
• When converting images to black and white the panel is automatically renamed B&W Mixer. Use the sliders to convert the way that color ranges are converted to levels of gray.
  - Option + Command + Shift + G (Mac) | Alt + Control Shift + G (Win) selects the Targeted Adjustment tool in the B&W mixer.

15. Split Tone Panel
• Option -drag (Mac) | Alt -drag (Win) either Hue slider in the Split Toning panel to temporarily view the colors at 100% saturation (making it easier to choose the desired hue). Then, release the keyboard modifier and use the Saturation slider to dial in the desired amount of color.
• Option -drag (Mac) | Alt -drag (Win) the Balance slider in the Split Toning panel to temporarily preview the Split Tone colors at 100% saturation (making it easier to see where the colors split in the image).

16. Optics Panel
• To achieve even vignette when cropping an image, enable “Use profile corrections” to remove vignetting caused by the lens and then, in the Effects panel, use the Post-Crop Vignetting options to apply vignetting based on the cropped image.
• To create your own lens profiles (for unique lens/camera combinations, use the free Adobe Lens Profile Creator Tool. All of the information that you need to know is here: https://helpx.adobe.com/photoshop/digital-negative.html
17. **Geometry Panel**

- For best results, enable “Remove chromatic aberration” and “Use profile corrections” in the Optics panel, before applying Upright Transforms.
- Rotated crops and manual perspective corrections on existing images will usually interfere with Upright transformations. For this reason, selecting one of the Upright modes (with the transform tool) will reset the crop and manual perspective adjustments (Horizontal, Vertical, Rotate, Scale, and Aspect controls). Resetting the crop has the benefit of showing the user the maximum amount of image area remaining after an Upright adjustment. To preserve these settings, Option + (Mac) | Alt + (Win) -click when choosing an Upright transformation.
- Shift + T selects the Transform tool.
- The Transform tool will generally work better on raw files because it can take advantage of more reliable metadata (e.g., focal length).
- Shift + G toggles the Grid overlay (Change Grid Size and Opacity using the sliders at the top of the window).
- Shift + L toggles the loupe on/off. Note: displaying the loupe requires GPU support.
- Option -drag (Mac) | Alt -drag (Win) displays a loupe and activates precision cursors (enabling a slower drag for accuracy without having to zoom into the image).
- Tap the V key to toggle the Guided Upright tool's overlay (the guides).
- Additional refinements can be made using the Manual Transformations:
  - The Aspect slider (in the Transform panel) can help remove vertical and horizontal distortions if an image is overly squished or stretched.
  - When using the Transform tool to correct perspective, the resulting image is often cropped in order to avoid displaying blank areas around the edges. To help retain necessary information from the original image that would otherwise be cropped use the Scale, X Offset, or Y Offset slider in the Transform panel to reposition the image within the canvas. Command + Option | Control + Alt -drag to reposition the image in the preview area via the Offset X/Y sliders. Add the Shift key (after starting to reposition the image) to constrain to horizontal/vertical directions.

18. **Effects Panel**

- There are three Post Crop Vignetting Styles:
  - Highlight Priority enables highlight recovery but can lead to color shifts in darkened areas of a photo. It is suitable for photos with bright image areas such as clipped specular highlights and behaves more like a traditional exposure burn.
  - Color Priority minimizes color shifts in darkened areas of a photo but cannot perform highlight recovery. This style also behaves more like a traditional exposure burn.
  - Paint Overlay similar to an overlay of black or white paint and can be useful when trying to apply even amounts of darkening/lightening.
- Both Highlight Priority and Color Priority styles include a Highlights slider. Increase the slider's value to reintroduce contrast in the highlights (and avoid muddy areas in images). The sliders effect is most noticeable if the vignetting is applied over bright areas such as highlights in a sky.
- The Grain effect deliberately varies from image to image to facilitate editing time-lapse and video frame sequences.

19. **Spot Removal Tool**

- Tap the B key to select the Spot Removal tool.
- Tap the V key to toggle the visibility of the spot overlays.
- Tap the left and right brackets to decrease/increase brush size. Add the Shift key to decrease/increase the feather.
- Control -drag left/right to decrease/increase the brush size. Control + Shift -drag left/right to decrease/increase the Feather (edge softness).
- Use the Opacity slider to decrease the opacity of a retouched spot (to minimize a distracting element instead of removing it).
- Shift -drag constrains the brush spot to a horizontal or vertical stroke.
- Shift -click connects the selected spot with the new spot via a straight brush stroke.
- Command -drag (Mac) | Control -drag (Win) will create a circle spot and allow you to drag to define the source.
- Tap the Forward Slash key (/) to select new source for existing circle or brush spot.
- Press Delete to delete a selected spot.
- Option -click (Mac) | Alt -click (Win) on a spot to delete it (the cursor will change to a pair of scissors).
- Option -drag (Mac) | Alt -drag (Win) in the image area over multiple spots to batch-delete.
- Tap the Y”key to toggle on/off Visualize spots. Tap “,” or “.” to decrease/increase the visualization threshold.

20. **Red Eye Removal Tool**

- Shift + E selects the Red Eye Removal tool.
- The Red Eye tool can also correct bright pupils in animals. For Type, select Pet Eye and use the Pupil slider and Catchlight options as desired.
21. Shared Shortcuts Between the Selective Edit Tools — The Adjustment Brush, Graduated Filter, and Radial Filter

- Tap V to toggle the visibility of the tool's interface.
- Tap the Y key to toggle the visibility of the mask overlay.
  - Click the color swatch to the right of the Mask Options to choose a different color to display as the mask overlay.
- Command + Option + R (Mac) | Control + Alt + R (Win) resets the edit options for the tool. Note: this shortcut is applied regardless of whether or not a local correction is selected. If no adjustment is selected, the shortcut simply resets the sliders to zero for the next correction that you create.
- Tap the N key to commit to the adjustment.
- Press the Delete key to delete the selected adjustment or, Option -click (Mac) | Alt -click (Win) an adjustment’s pin to delete it.
- Command + Option -drag (Mac) | Control + Alt -drag (Win) the pin to duplicate the adjustment.
- Control -click (Mac) | Right -click (Win) the selected adjustment’s pin to select additional options from the context sensitive menu (i.e. Duplicate, Delete, Reset Local Correction Settings).

When painting using the Adjustment Brush, and/or the Graduated and Radial Filter’s modification brush:
- Option + “[” or “]” (Mac) | Alt + “[” or “]” (Win) decreases/increases brush size. Add the Shift key to decreases/increases Feather (edge softness).
- Tap “+” (plus) or “-” (minus) to increase/decrease Flow.
  - Flow sets the speed at which the brush applies the adjustment. Lowering the Flow amount enables a slower build up of an effect and can reduce the number of individual pins needed to modify an image as one can apply different amounts of the same adjustment in different areas without having to create a new pin for each different amount.
  - Density caps the amount of the adjustment that can be applied (even with multiple strokes)
- Control -drag left/right to decrease/increase the brush size. Control + Shift -drag left/right to decrease/increase the Feather (edge softness).
- Option (Mac) | Alt (Win) toggles the Brush/Eraser for the Adjustment Brush and the Add To/Subtract From for the Filter’s modification brush.
- To keep the brush and eraser size the same, click the More icon (the three dots at the top of the Brush panel) and disable “Separate Eraser Size” from the menu.
- Camera Raw supports pressure-sensitive devices such as Wacom and Microsoft Surface Pro tablets. Pressure applied to the pen affects the Flow. Turning the pen over and using the “eraser” side automatically switches the brush to the eraser mode (if your pen supports this feature).
- By default, ACR resets the sliders between each new adjustment. To keep the same adjustments, at the bottom of the Selective Edits, uncheck the “Reset sliders automatically” option
- Use the More Local Corrections menu (the three dots at the top of the local corrections panel) to save presets for frequently used settings.
- When using the Range Mask feature, Option -drag (Mac) | Alt -drag (Win) on the Color Range/Smoothness slider to preview the corresponding mask.
- Shift -click with the Eyedropper while in Color Range Mask to select multiple colors. Drag to select a range of Colors.

22. Adjustment Brush

- Tap the K key to select the Adjustment Brush.
- Shift -drag constrains the Adjustment Brush to a straight line.
- Tap the M key to toggle on/off Auto Mask (Auto Mask automatically detects edges based on contrast and color to help apply adjustments to a selective area).

23. Graduated Filter

- Tap the G key to select the Graduated Filter.
- Shift -drag with the Graduated filter constrains it to 15 degree angles.
- The length of the gradient determines how quickly the adjustment fades. To adjust the Gradient:
  - Drag the red or green dot to adjust the length of the fade range.
  - Drag the black dashed line to reposition the Graduated Filter.
  - Drag the red or green dashed lines to rotate it.
- Shift + K toggles between editing the Graduated filter and the Brush modification mode (used to edit the mask).

24. Radial Filter

- Tap the J key to select the Radial Filter.
- Shift -drag constrains the Radial Filter to a circle.
- With a Radial Filter selected, press the X key to toggle the effect direction from outside to inside.
- While dragging one of the four handles of an existing Radial Filter to resize it, press the Shift key to preserve the aspect ratio of the ellipse.
• While dragging the boundary of an existing Radial Filter to rotate it, press the Shift key to snap the rotation to 15-degree increments.
• While dragging to create a new Radial Filter, press and hold the Space bar to reposition the ellipse; release the Space bar to resume defining the shape of the new Radial Filter.
• While dragging inside of an existing Radial Filter to move it, press the Shift key to constrain the movement to the horizontal or vertical direction.
• You can drag a Radial Filter beyond the image area.
• Double-click in the image area to set the bounding box of the Radial filter to “Fill” the image bounds.
• Shift + K toggles between editing the Graduated filter and the Brush modification mode (used to edit the mask).

25. Snapshots Panel
• Shift + S displays the Snapshots panel.
• Command + Shift (Mac) | Control + Shift (Win) creates a new Snapshot. A Snapshot “captures” all of the edits applied to an image and saves them as a single entry in the Snapshot panel. You can then take the image in another direction with the security of knowing that you can quickly return to the Snapshot “state” with a single click.
• Snapshots are available when the file is opened as a Smart Object into Photoshop (making it easy to quickly move between different edits of the same image when designing a layout or making a multi-image composite).

26. Presets Panel
• Shift + P displays the Preset panel
• Presets are stored by default here:
  - Windows: Win (user)/Application Data/Adobe/Camera Raw/Settings.
  - Mac: Mac (user)/Library/Application Support/Adobe/Camera Raw/Settings. Note: on Mac, hold the Option key down while selecting the “Go” menu in the Finder to reveal the Library folder.
• Control -click (Mac) | right -click (Win) on a custom preset to access a wide variety of options (Preset Info, Add to Favorites, Rename Preset, Update with Current Settings, Manage Presets, Import Profiles & Presets and more).
• Control -click (Mac) | right -click Win on a preset to select it as a Raw Default for all raw files or a specific Camera model.
• Hover the cursor over a preset and click the Favorite (star) icon to add it to the Favorites group at the top of the Presets panel.
  - Favorites can be quickly applied to images in Adobe Bridge by selecting Edit > Develop Settings > Preset xxx.
  - Setting can also be removed in Bridge (Edit > Develop Settings > Clear Settings).

27. Color Sampler Tool
• Tap the S key to select the Color Sampler tool. Click in the image area to add a maximum of 9 Color Samples per image.
• Option -click (Mac) | Alt -click (Win) on a color sample to delete it (the icon changes to a pair of scissors).
• With the Color Sampler tool selected, click the Reset icon (on the Sample Info bar) to remove all Color Samplers at once.
• With the Color Sampler tool selected, press and hold the Shift key to temporarily access the White Balance tool.

28. Soft Proofing
• Camera Raw includes the ability to select RGB, CMYK and LAB ICC profiles to soft proof images. To select a profile, click the Workflow Options hyperlink at the bottom of the Camera Raw window and, in the Color Space section, choose the desired profile from the pop-down menu. Once a profile is selected, Camera Raw displays a “soft proof” of that image. In addition you have the ability to choose either Perceptual or Relative as your rendering Intent and can choose whether or not to Simulate Paper and Ink. There is not an option for Black Point Compensation because it is always enabled in Camera Raw.
• Grayscale color profiles are only displayed when processing a monochrome image or when converting a color image to grayscale.
• When using a Lab or CMYK color space, the histogram and color readouts will change accordingly.
• For accurate results, monitor calibration is a must! In addition, there may very well be some colors that simply aren't reproducible on a monitor that can be printed and vice versa.

29. Grid Overlay
• Shift + G toggles a grid over the image.
• Use the Grid Size and Opacity settings that appear at the top of the screen to customize the grid or, [ and ] decreases/increases the grid size; add the Shift key to decreases/increases opacity.
30. Before and After Previews options

- Click the Cycle between Before/After Views button to cycle through left/right and top/bottom side-by-side and split-view modes.
  - Tap Q to cycle through the Before/After Views.
  - Click-and-hold the Before/After icon to quickly select a specific Preview mode from the menu.
  - Click-and-hold the Before/After icon to access and customize Preview Preferences.
- Click the Swap Before/After settings button to swap settings.
  - Tap the P key to swap Before/After settings for the primary selected image only.
- Click the Copy button to copy the After settings to the Before settings (useful for establishing a temporary “checkpoint” for an editing session).
  - Option + P (Mac) | Alt + P (Win) copies After settings to the Before settings for the primary selected image only.
  - Option + Shift + P (Mac) | Alt + Shift + P (Win) copies After settings to the Before settings for all selected images.

31. Save Image Options

- Command + S (Mac) | Control + S (Win) displays the Save Options window.
- Option -click (Mac) | Alt -click (Win) the Save icon to save the selected images using the last applied settings (bypassing the Save Options dialog).
- Use the Preset menu to save presets for frequently used Save settings.
  - Control -click (Mac) | right -click (Win) to apply Save presets via the context sensitive menus.

32. Workflow Options

- Before opening files into Photoshop, click the hyperlink at the bottom of the window to choose Workflow options including Color Space, Image Sizing, Output Sharpening, and Photoshop options.
- Save frequently used settings as presets using the Presets menu at the top of the Workflow Preferences. Control -click (Mac) | right -click (Win) the workflow hyperlink to quickly switch between workflow presets.
- Command + O (Mac) | Control + O (Win) opens the image.
  - Command + Option + O (Mac) | Control + Alt + O (Win) opens a copy.
  - Command + Shift + O (Mac) | Control + Shift + O (Win) opens as a smart object.
- Hold the Option (Mac) | Alt (Win) key to toggle Open to Open Copy (useful for opening multiple copies of the same file processed in different ways).
- Hold the Shift key to toggle Open to Open Object to open an image in Photoshop as a Smart Object without having to edit the Workflow options. Note: if the Workflow settings are set to Open as Smart Object, the Shift key will toggle from Open Object to Open.
- Holding the Option (Mac) | Alt (Win) key toggles Cancel to Reset”. Click Reset to revert the image settings to the beginning of the session (this may or may not be the camera defaults if it's not the first time the image is opened in Camera Raw).

33. Syncing Edits Across Images

- To make changes to multiple images at once, select them in the filmstrip.
  - Command + A (Mac) | Control + A (Win) selects all images.
  - Command + Option + A (Mac) | Control + Alt + A (Win) selects all rated images.
  - Command + D (Mac) | Control + D (Win) deselects all but the “most selected” image (the one that you’re viewing in the image area)
  - With multiple images selected, Option -click (Mac) | Alt -click (Win) the thumbnail of a selected image to make it the active image while keeping all of the other images selected.
- To quickly copy and paste edit settings from one image to the next, select the edited image in the filmstrip and use the shortcut Command + C (Mac) | Control + C (Win). Then, select the desired image and use the shortcut Command + V (Mac) | Control + V (Win) to paste the settings. For more control over which settings are copied, use the shortcut Command + Option + C (Mac) | Control + Alt + C (Win) to display the Copy Edit Settings dialog. Note: the Copy Edit settings can also be accessed from the context sensitive menus (Control -click (Mac) | right -click (Win) in the image area or on a thumbnail in the Filmstrip, and choose Copy Edit Settings/ Copy Selected Edit Settings).
- With multiple images selected, Option + S (Mac) | Alt + S (Win) displays the Synchronize dialog (enabling you to choose what settings to synchronize). Add the Shift key to bypass the dialog.
- With multiple images selected, moving a slider will set the same value for each image. However, some settings will be applied based on the image content including: Lens Correction (Remove Chromatic Aberration and Enable Profile Corrections) Auto Upright Modes, Auto Tone, and Auto Black and White Mix. Note: to apply the same numeric settings across all selected images, apply the settings the first image, then choose Sync from the filmstrip’s drop-down menu and choose the items to be synchronized (White Balance, Exposure, Contrast, etc.).
34. Merge to HDR

- To merge multiple exposures to a single HDR images, select the images in the filmstrip, click the More icon and select Merge to HDR or, use the shortcut Option + M (Mac) | Alt + M (Win).
- Before running Merge to HDR, in the Optics panel, enable (check) Remove Chromatic Aberration and Lens Corrections and apply spot corrections to the source images before merging (this is useful if there are spots that occur in the same spot in every image (dust on the sensor, for example); fix the spot in one, sync the spot corrections to the others, then merge).
- Not all adjustments made to individual images carry over when selecting Merge to HDR. For example, if you have made local adjustments on individual exposures, those adjustments will not be applied to the merged file. Because of this, I would suggest that you don’t spend a great deal of time making adjustments to each of the individual exposures but instead, merge the images and then make adjustments to the resulting RAW, HDR image. Note: For HDR, the merge tool is expanding tonal range, so existing primary tone settings (such as Exposure, Contrast, Highlights, Shadows, Whites, and Blacks) are not copied over.
- If you make adjustments to an individual exposures that can be copied over to the merged file (such as conversion to B/W or Split Toning adjustments), make sure that the exposure with the adjustments is the active or “most selected” image before running Merge to HDR.
- Tap the A key to toggle the Align Images feature.
- Tap the T key to toggle Auto Tone.
- Tap the Y key to show the Deghost Shadow Overlay.
- HDR merging requires exposure metadata. If aperture and ISO information is available, then it is used as well. Camera Raw will show an error if you try to merge photos of different sizes, focal lengths, etc.
- Option + Shift + M (Mac) | Alt + Shift + M (Win) will run Photo Merge > HDR based on the last used Merge settings (bypassing the dialog).
- By default Camera Raw appends the resulting image’s file name with -HDR.
- The resulting (merged) HDR files will always default to the current Process Version.

35. Merge to Panoramas

- To stitch multiple exposures to a single panorama, select the images in the filmstrip, click the More icon, and select Merge to Panorama or, use the shortcut Command + M (Mac) | Control + M (Win).
- Before running Merge to Panorama, apply spot corrections to the source images (this is useful if there are spots that occur in the same spot in every image (dust on the sensor, for example); fix the spot in one, sync the spot corrections to the others, then merge).
- If you have made adjustments to the individual images prior to choosing Merge to Panorama, not all of them carry over to the merged file. For example, if you have made local adjustments on individual exposures, those adjustments will not be applied to the merged file. Because of this, I would suggest that you don’t spend a great deal of time making adjustments to each of the individual exposures but, instead, merge the images and then make adjustments to the resulting Panorama image. Note: For a Panorama, the merge tool is changing geometric attributes, and will therefore not copy over existing geometric settings such as Lens Corrections/Upright (with the exception of Defringe settings).
- If you make adjustments to an individual exposures that can be copied over to the merged file (such as conversion to B/W or Split Toning adjustments), make sure that the exposure with the adjustments is active or “most selected” image before running Merge to Panorama.
- Command + 1/2/3, (Mac) | Control + 1/2/3 (Win) will quickly select different projection options (1=Spherical, 2=Perspective, 3=Cylindrical.
- Tap the C key to enable Auto Crop.
- Use the Boundary Warp slider to adaptively stretch or reshape the edges of a stitched panorama to fill the rectangle boundary.
- Command + Shift + M (Mac) | Control + Shift + M (Win) will run Merge to Panorama based on the last used settings (bypassing the dialog).
- By default Camera Raw appends resulting image’s file name with -Pano.
- There is a size limit of 65,000 pixels on the long side of a file or, 512 MP - whichever comes first.
- The resulting Panorama will always default to the current Process Version.

36. Camera Raw Preferences

- Command + K (Mac) | Control + K (Win) displays the Camera Raw Preferences.
- Preferences > Performance—When moving back and fourth between multiple images, it can be a performance advantage to increase the Camera Raw Cache when working with raw files. The larger the cache, the greater the number of images Camera Raw can hold onto for quick access - making it faster to load recently viewed images. If you are simply moving from one image to the next (without returning to the previously viewed images), then you may not see a benefit from increasing the Camera Raw Cache.
37. Using Camera Raw without launching Photoshop
   • For most people, the fact that Camera Raw is a plug-in that works in both Bridge and Photoshop is completely transparent. The most common workflow is to find the desired image in Bridge, double click to open it in Camera Raw and start making edits. When finished editing, clicking the Done button will close Camera Raw and leave you in Photoshop. If, instead, after selecting images in Bridge, you choose File > Open in Camera Raw, click the Open in Camera Raw icon, or Command+ R (Mac) | Control + R (Win), Bridge launches the Camera Raw plug-in so that it runs within Bridge (not Photoshop). The advantage to this workflow is that you can make edits using Camera Raw without having Photoshop open and, when you are finished making edits in Camera Raw, clicking the “Done” button, returns to Bridge.

38. Bypass the Camera Raw Dialog when Opening From Bridge
   • Shift-double clicking on a RAW image in the Bridge will bypass the Camera Raw dialog, applying either settings that have been saved with the file, or if there are no settings applied, opening the file with the camera defaults into Photoshop.